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Declaration

Thank you for choosing our product. Before using the product, please read this manual carefully.

No part of this document shall be quoted or reproduced in any form or disclosed to any third party without
prior written permission of InHand.

The contents of this document are subject to change without prior notice as a result of continuing
improvements to the product. InHand cannot promise that the contents are consistent with the actual product
information, and assumes no responsibility for any disputes arising out of the discrepancies. InHand reserves
the right to update and interpret information in this manual.

Copyright © 2022 Beijing InHand Networks Technology Co., Ltd. and its licensors. All rights reserved.

GUI and Symbol Conventions

[] Represents a function module or menu, such as: in the [ Status] menu.
S Multi-level menus are separated by the ">" signs. For example, choose File > Create >
Folder.
. Please be careful of the contents under Cautions, improper action may result in loss of
Cautions .
data or device damage.
Note Note contain detailed descriptions and helpful suggestions.

Technical Support

Email: support@inhandnetworks.com

URL: www.inhandnetworks.com
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1 Overview

Edge Router 605 (ER605 for short) is a next-generation 5G edge router developed by InHand to provide fast
and secure network connections for business applications. Leveraging 4G/5G cellular networks and various
broadband services, ER605 provides ubiquitous, uninterrupted access to the Internet for a variety of business
devices. With comprehensive security and wireless features, it establishes real high-speed channels for data
transfer between devices.
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Figure 1 ER605 application
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2 Hardware

2.1 Indicator Description

LED Indicator

Status and Description

System status
indicator

Off — The router is off.

Solid red — The system is starting.

Blinking — The system is running properly.
Blinking red — The system does not work properly.
Blinking — The system is upgrading.

Connectivity status
indicator

Off — The router is not connected to network.

Blinking red — The router is connecting to the cellular network.

Solid green — The router has connected to the cellular network successfully.
Blinking blue — The router is connecting to the wired network.

Solid blue — The router has connected to the wired network successfully.

Cellular signal

Off — No signal.
Solid red — Signal strength is poor.

indicator Solid — Signal strength is good.
Solid green — Signal strength is excellent.
Off: The Wi-Fi 2.4 GHz band is off.

Wi-Fi 2.4G Solid — The Wi-Fi 2.4 GHz does not work properly.
Blinking — The Wi-Fi 2.4 GHz band is working properly.
Off: The Wi-Fi 5 GHz band is off.

Wi-Fi 5G Solid green — The Wi-Fi 5 GHz does not work properly.

Blinking green — The Wi-Fi 5 GHz band is working properly.

Note: If both the cellular and wired networks are connected, the connectivity status indicator shows yellow
(wired network). If one of networks is not connected, the indicator shows the color corresponding to the
connected network. If neither network is connected, the indicator shows red.
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2.2 Installation
2.2.1 Mounting method

® Desktop installation

Stick a black rubber foot pad on the back of the router

After pasting the four rubber foot pads, place them flat on the table

® [ug installation

Fix the lug on the side of the router with screws, and then fix the device on the wall with fixing bolts

2.2.2 Installation
Stepl:Take out the SIM card holder with the card pin and place the SIM card

(Users can also choose to use the network cable to access the WAN1 port to connect to the Internet)
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WAN2/LAN1 LAN2

Step3:Power the router

2.3 Using the Reset Button to Restore Factory
Settings

DC 9-38V

Step 1: Power on the device (10 seconds), press and hold the reset button until the SYS indicator is steady
yellow

Step 2: Release the button, wait for the SYS LED to flash yellow.
Step 3: Press the reset button again until the SYS indicator is steady yellow
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Default Settings

No. Function Default Settings
1 Cellular network | — Both SIM cards are enabled, and SIM1 is used preferentially.
dial-up
— The Wi-Fi 2.4 GHz access point (AP) is enabled, and its SSID is
ER605— followed by the last six digits of the wireless MAC address.
- The Wi-Fi 5 GHz AP is enabled, and its SSID is ER605-5G—
2 Wi-Fi followed by the last six digits of the wireless MAC address.
—  The authentication method is WPA2-PSK.
— The two access points have the same password: last eight digits of the
router's SN.
—  Four LAN interfaces are enabled.
—  The IP address is 192.168.2.1.
3 Ethernet -~ The subnet mask is 255.255.255.0.
— The DHCP server is enabled to allocate IP addresses to connected
devices from the address pool 192.168.2.2-192.168.2.100.
4 Network access — Local HTTP and HTTPS services are enabled, using ports 443
control —  Access from the cellular network is disabled.
User name and — The user name is adm (super administrator), and the password is
5
password 123456.
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4 Quick Network Connection

4.1 Environment Setup

Step 1: Install the 4G/5G and Wi-Fi antennas, and insert SIM cards into the router.
Step 2: Connect the power cable and Ethernet cable, and connect any of LAN interfaces to a PC.
Step 3: Assign an [P address to the PC, which must be in the same network segment as the router.

As the dhep server function is enabled by default on the LAN interface, the PC must be in the same network
segment as the router. On the PC, set IP address to any value in the range of 192.168.2.2-192.168.2.254,
Default gateway to 192.168.2.1, Subnet mask to 255.255.255.0, Preferred dns server to 8.8.8.8, and
Alternate dns server to the IP address of the carrier's dns server.

Internet Protocol Version 4 (TCP/IPwd) Properties = Internet Protocol Version 4 (TCP/IPvd) Properties >
Genaral | Genaral |
|

You can get TP settings assigned automatically if your netwark You can get TP settings assigned sutomatically i your network

Supports this capability. Otherwise, you nised to ask your netwark Supports this capability. Otherwise, you need to ask your nitwaork

administrator for the appropriate P settings. adrministrator for the appropriate TP settings.

|"..'. Obtain an IF address automatically ' ;.Clbtam an IF address automatically
Jse the following IF address: (@) Use the following [P address:

I address: 192 168 . 2 . 2

]

Subnet mask: 255,255 .255. 0

atawEy g & s Default gateway: 192.168 . 2 . 1

(@) Obtain DNS server address automatically

Uses the Tallowing DNS server addreases (@) Use the following DNS server addresses
Preferrad DNS server i 5 g Preferred DNS server: 8 .8 .8 .49
Altemate DNS server: " n x Alternate DMNS server:
I__ Validate sefttings upon exit Advanced.. ﬂ‘;alina!v settings upon exit Advanced..

Figure 4-1-1 Dynamic/Manual IP address configuration on the PC

Step 4: Start the web browser and enter the router's default IP address 192.168.2.1 in the address box. On the
login page that appears, enter the user name and password (adm/123456 by default) to log in to the
web-based management system of the router. If the web browser displays a message, indicating that the
website is not secure, unfold the hidden or advanced settings and choose to continue.
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Internet of everything,

accompanied by routers — 3% ERB05

®)

# 4

Figure 4-1-2 Login to the web-based management system

4.2 Internet Connection

The ER605 can connect to the Internet via three types of interfaces, each allowing for multiple connection
methods. The router has two default uplink interfaces WANI1 and Cellular, which cannot be removed. It
supports a maximum of four uplink interfaces, namely, WAN1, WAN?2, Cellular, and Wi-Fi(STA). WAN2
and Wi-Fi(STA) need to be added manually and can be removed.

42.1 Wired Connection Via a WAN Interface

The ER605 can establish a wired connection through DHCP, a static IP address, or PPPoE. To select a
connection method, click [ Internet ] on the left pane, and then click Edit in the row of WANI

2%, ER6OS N s

Device Information

ame: ER605 £ Model: ER605-NRQ2-WLAN fersion: V203

MAC: 00:18:05:00:02:04 Uptime: 6 days 23 hours 38 intemet Access: WAN1 Uplink IP: 10.5.47.158

Local Gateway IP: 192.168.66.10 System Time: 2022-12-26 15:16:23 UTC +08:00

T VPN Interface Status

- =

& system Cellular WANT  LANT|[WANZ  LAN2 LANZ LANS
Il connected Disconnected [ Abnormal Disabled
Traffic Statistics

Cellular(siM1)

Figure 4-2-1-a Editing interface WAN1

e DHCP: The DHCP service is enabled on the WAN interface by default. Therefore, the router can
connect to the Internet immediately when the WAN interface is connected to the Internet with an
Ethernet cable.
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Edit WAN!1 X

Name: WAN1
Status: @)

NAT:

Type: | DHCP W

w MTU: | 1500

Figure 4-2-1-b DHCP mode

e Static IP address: Manually assign an IP address obtained from the carrier or upstream network device.
Then, the router can connect to the Internet using this static IP address.

Edit WAN1 X

Mame: WAN1

status: @D

NAT:

Type: ‘ Static IP W

* |P Address:

* Mask:

* Gateway Address:
* Main DNS:
Secondary DNS:

*MTU: | 1500

Cancel Save

Figure 4-2-1-c Assigning a static IP address to the router

*  PPPoE: Configure the PPPoE service on WANI1. Then, the router can dial up to the Internet through the broadband
service.
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Edit WAN1 X
Mame: WAN1
status: @D
NAT:
Type: | PPPoE A

# User Name: ‘ |

* Password : ‘ & |

Local IP Address: ‘ |

Remote IP Address: ‘ |

Figure 4-2-1-d Configuring PPPoE

To use the second WAN interface, click Add on the [ Internet] page to add WAN2. This interface provides the same
functions as WANI1.

*MTU: | 1500

e

Figure 4-2-1-¢ Adding WAN2

Notes:

After you add WAN?2, interface LAN1 changes to WAN?2.
After you remove WAN?2, the interface changes back to LANI.

When WAN?2 is removed, all configuration on this interface, including the static routes, inbound and
outbound rules, port forwarding, policy-based routing, VPN, and traffic shaping, is deleted.

configurations take effect only after saving.
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4.2.2 Wireless Connection via the Cellular Interface

Generally, the ER605 dials up to the cellular network automatically after you install the SIM cards and
antennas according to the installation guide, and power on the router. To set the access point name (APN),

click [ Internet ] on the left pane, and then click Edit in the row of Cellular.

$3%, ERBOS

@ Dashboard

B status

8 memet |
@ Local Network

= Wi-Fi

¢ veN

@ Security

® Services

© System

& InCloud Manager

Uplink Table
+ add
priority
+=

=

@ Internet adm v R
Name Status Interface Type Type Actions
WANT Enable waAN DHCP 2 edit
Cellular Enable Cellular: SIM1 Dialup @rolicy

Note: Maodifying the configuration of the intemet interface or adjusting the priority may cause the device netwark to be interrupted:

Uplink Setting
Link Detection:
Test Connectivity to

Enabled

@®) Link Backup
Failover Mode:

Load balancing

Last Time

5 min

5 min

5 min

5 min

Detection ltem Constraint Value
Latency is less than 200 ms
Jitter is less than 200 ms
Loss is less than 5%
Signal strength i greater than Poor

Immediately Switch v/

Figure 4-2-2-a Editing the cellular interface

10
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Edit Cellular X

Status: 'D

MNAT:
Work Mode: | Only SIM1 v
PDP Type: | IPv4 v
Dialing Parameters: | Auto W
Service Type: | Auto W
5G Type: | SA/NSA v
PIN Code:
IMS: | Auto W

#MTU: | Auto Vv

Mask: | 255.255.255.255

Cancel Save

Figure 4-2-2-b Editing the cellular interface

Among them, the SIM card working mode can be optionally configured with SIM1 only, SIM2 only, and dual SIM
mode, and the PDP Type can be optionally configured as Ipv4, Ipv6, Ipv4&Ipv6. Network standard can choose 3G, 4G,
4G/5G, 5G SA; The dialing parameters are configured as automatic by default, you can choose manual configuration
mode and enter APN, username, password, select the authentication mode 5G Type, optionally configure SA, NSA,
SA/NSA mode.

11
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Edit Cellular

status: @D
NAT:

Work Mode:

PDP Type:

Dialing Parameters:

APN:

* Authentication:

User Name:

Password :

Service Type:

5G Type:

PIN Code:

IMS:

*+ MTU:

Mask:

Figure 4-2-2-c Manually configure dialing parameters

Only SIM1

IPv4

Manual

Auto

Auto

SA/NSA

Auto

Auto Vv

255.255.255.255

InHand ER605 User Manual @

X

The ER605 allows you to set traffic policies for cellular network access. After a traffic policy is enabled, the working
SIM card will take the specified action when the traffic usage reaches the set threshold. click [ Internet ] on the left
pane, and then click Policy in the row of Cellular.

12
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o
¥, ER605 & InCloudManager  ® lnternet adm >
@ Dashboard Uplink Table
B status + Add
€ Internet | Priority Name Status Interface Type Type Actions
@ Local Network -
= Cellular Enable Cellular: SIM1 Dialup 2 Edit
= Wi-A
= WAN1 Enable WAN Static IP 2 Edit
% VPN
) = Wi-Fi(STA) Disable Wi-Fi(STA) DHCP 2 Edit | Delete
O Security
W senice: Note: Modifying the configuration of the internet interface or adjusting the priority may cause the device network to be interrupted!
& system
Uplink Setting
Link Detection: [ @]

Detection Address 1:

Detection Address 2:

Enabled Last Time Detection Item Constraint Value
5 min Latency is less than 200 ms
= 5 min Jitter is less than 200ms

Figure 4-2-2d Setting the cellular traffic policy

Edit SIM Card Policy X

SIM1 Threshold: (i

* Threshold: | 1 | GB v

Monthly Reset Day: | 1 v
Action: | Notification W

Usage of the month: 0 KB Modify

SIM2 Threshold: ()

* Threshold: | 1 GB v

Monthly Reset Day: | 1 v
Action: | Notification v

Usage of the month: 0 KB Maodify

Figure 4-2-2-e Configuring a traffic policy for cellular network access
Actions:
e Notification:record the generated traffic reaching the threshold event, and the traffic transmission is not restricted.

e  Only Cloud Management:record the generated traffic reaching the threshold event, only keep the traffic of the
cloud management device, and the access to the Internet traffic will be restricted.

e  Switch SIM:record the generated traffic reaching the threshold event and trigger SIM card switching.

Notes:

13
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When the router is used on a private network, disable link detection on the [ Internet ] page. Otherwise, the
cellular interface cannot work properly, because the cellular link cannot be detected.

In some cases, you need to enter the subnet mask of the cellular interface to ensure proper functioning of ARP.

Before removing or installing a SIM card, unplug the power cable of the router to prevent data loss or damage to
the router.

4.2.3 Wireless Connection via Wi-Fi(STA)

The ER605 can connect to an AP as a wireless client (STA). To use this connection method, click Add on
the [ Internet ] page, select Wi-Fi(STA) in the dialog box that appears, and enter the SSID and password.

Add Internet X

MNote: When the Wi-Fi (STA) interface is added, SSID(s)
with the same band will be disabled

Name: waN2 (@) wi-Fi(sTA)
status: @D
NAT:
Band: (@ 2.4GHz 5GHz
* 551D
Security: | WPA2-PSK v
Encryption: | CCMP W
* Password : &
Type: | DHCP W
*MTU: | 1500

Figure 4-2-3 Adding the Wi-Fi(STA) interface

Notes:

After you add the Wi-Fi(STA) interface, the SSIDs of the router on the same frequency band are disabled and
cannot be enabled manually.

After you delete the Wi-Fi(STA) interface, the SSIDs on the same frequency band can be enabled or disabled
manually.

When the Wi-Fi(STA) interface is deleted, all configuration on this interface, including the static routes, inbound
and outbound rules, port forwarding, policy-based routing, and traffic shaping, is deleted.

14
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Click [ Dashboard ] on the left pane to display the dashboard of the router, on which you can view basic
device information, interface status, traffic statistics, cellular signals, and number of Wi-Fi connections.
2%, ERB0S & InCloud Manager  © Internet
o o Device Information
B s Name: ER605-test £ ER605-NRQ2-WLAN Serial
8 et C: 00:18:05: 4 days 5 hours 37 mi
"r VPN Interface Status
© Security
@ Services

Cellular(SIM1)

InCloud Manager Branch Pr...

Uplink IP: 10.77.97.15
i e | T s
Il Connected 1] Disconnected [ Abnormal Disabled
Traffic Statistics
Cellular(sIM1) 71328 MB
.
Wi-Fi Connections Clients Traffic Top5
A4 00:0eic6:3b... 470.14MB.

Figure 5 Dashboard

. evice Information

Device Information

and uplink interface address vary depending on the working uplink.

ERGO5-test £

00:18:05;

P: 192168.2.10

ER605-NRQ2-WLAN

days 5 hours 39 mi...

Basic information about the router is displayed on the top of the dashboard. The network connection method

2023-07-10 15:21:33 UTC +08:00

<5t Cellular(SIM1)
License St

Figure 5-1 Device information
5.2 Interface Status

P: 1077.97.15

detailed information about the interface.

The status of each interface is displayed clearly on the dashboard. You can click any interface icon to view

15
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X Interface Status

Wi-Fi(STA)

Cellular

Status:
Work Mode:
SIM:

Signal Strength:

1Pv4 Address:
Gotevay Address:
Primary DNS:
Secondary DNS:

Test Connectivity to:
1PV6 Address:

Used Traffic/Threshol:
IeciD:

IMEE:

IMsi:

Connect Time:

Figure 5-2 Interface status

5.3 Traffic Statistics

Connected
Active

sIM1

5G(sA)
ctnet
10.77.97.15/32
1077.97.1
61.139.269

2186200139

115768/ -

538

633084

78

Traffic Reset Time: 3 weeks 8 hours 27 minutes left

4 days 3 hours 44 minutes

You can check traffic statistics collected on each uplink interface since the router is powered on. Traffic
statistics are reset after a reboot of the router. To view historical traffic statistics, log in to InCloud Manager

and enter the details page of the router.

Traffic Statistics

WAN1

175GB
Wi-Fi(STA) [ 10.78 MB

Figure 5-3 Traffic statistics

5.4 Number of Wi-Fi Connections

You can view the number of SSIDs enabled on the ER605 and number of clients connected to each SSID.

Wi-Fi Connections

@ ERE05-000206
@ ER605-5G-000207

Figure 5-4 Number of Wi-Fi connections

16
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5.5 Top 5 Clients by Traffic

You can view the rankings of clients connected to the router by their traffic statistics. A maximum of five
records can be displayed. When a client is disconnected from the router, its traffic statistics are cleared.

Clients Traffic Top5
- _____________________________________________________________________________[ENEj
DESKTOP-B... I /9375 ME
chengdou-... I 221.58 MB
AER1650-163 || 2563 MB

Figure 5-5 Top 5 clients by traffic

17
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6 Status

Click Status on the left pane to display the [ Status] page, where you can view information about uplinks,
cellular signals, clients, VPNs, events, and logs of the router.

6.1 Link Monitor

The [ Link Monitor ] module displays the health of each uplink, as well as the throughput, delay, packet
loss rate, and signal strength on each uplink interface.

s ERBOS & InCloud Manager ~ ® intemet v
® Dashboard Link Monitoring ~ Cellular Signal ~ Clients VPN Events  Logs
B status | Link Health
& intemet Status Uplink Carrier Usage Throughput Latency Loss Signal Strength(dBm)
@ Local Network . 4 50.10MB 39674 Kb/s §

. want = ¥ 35488 MB 8028 Kb/s 278 ms 0%
= Wi

Cellular(siM1) - Tt bl 0000ms - odem
e ¥ 45961 MB v- h
Securit
o % WANT v
W Services Throughput
@ System
. o I W} J
134500 140000 14:15:00 1430:00 144500 150000 151500

Latency

500000 ms

400,000 ms I

300000 ms

200000 ms

100000 ms

0000 ms | R | | Ll L L | o A PORRLl 15, Y
133000 134500 140000 1415:00 1430:00 144500 150000 151500

Figure 6-1 Link Monitor

6.2 Cellular Signals

The [ Cellular Signals ] module displays the SIM card signal strength on the cellular interface, as well as

other parameters such as the received signal strength indication (RSSI), signal to interference plus noise ratio
(SINR), and reference signal receiving power (RSRP).

2%, ERBOS  InCloud Manager  ® Internet PO
® Dsnbos UnkMonitoring  CellarSignal  Clients VPN Evnts  Logs
B s |
Signal Srength o
& Intemet
@ Local Network
= Wi
¥ VPN
© Security
® Semvices
Rssi sun
© System =
P
©
o
™
0
o
0
SINR oy
©
»
»
0
0
0
B
RSRP s
“
= 50

Figure 6-2 Signal strength
18
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6.3 Clients
The [ Clients ]

2%, ERBO5

@ Dashboard
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# InCloud Manager @ Internet
Link Monitoring Clients VPN Events
LR | Wired 2 | Wireless 1 Neme vV
£ Internet
Name IP Address
® Local Network
EAP600
= WiFi
% VPN
@ Security

MAC Address
192.168.95.155
Redmi
@ Services
o system

192.168.95.185
HUAWEI_P30_Pro-5...

1
192.168.95.167

module displays details about each client connected to the router, such as its name, IP
address, MAC address, VLAN ID, connected subnet, traffic statistics, and online duration.

Connection

adm v %
Traffic up Down Uptime
Default 707.08 KB 24580 KB 461.28 KB 4 hours 50 minutes
Default 1812 M8 554 MB 12.58 MB s’;{‘z:;z eSS0
1 eht-2g 4444 KB 11.81 KB 32.63 KB 31 seconds
1-3of3items < >
Figure 6-3 Clients
6.4 VPN
The [ VPN] module displays information about IPSec VPN and L2TP VPN, such as their status, name,
traffic statistics, and duration of the latest connection.
.f},‘?';a ER605 & InCloud Manager ~ ® Intemnet adm v %
@ Dashboard Link Monitoring ~ Clients VPN Events  Logs
B Sty | IPSec | L2TP
& Intemet
Status Name Uplink Interface Interface Address Remote Address Available Subnets Traffic Last Connection Time
@ Local Network
L] 605-IPSec WAN1 10.547.45 10.5.47.96 192.168.95.0/24 - 192.168.2.0/24 21.80KB 5 minutes 16 seconds
= Wi-fi
¢ VPN
Q@ Security
@ Services
© System
6.5 Events

Figure 6-4 VPN

19
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The [ Events ] module displays the events that have occurred during operation of the router, helping you
understand its running status.

=
.:},‘}'u ERB0O5 & InCloud Manager ~ ® Internet adm > %%
@ Dashboard LinkMonitoring ~ Clients VPN Events  Logs
g g
Clus | ~ End dat [S) v ClearEvents | Export Events| C
& Intemet
Time Type Content
@ Local Network
- 2023-07-10 16:4205 Uplink status changed Wi-FI(STA) Is connected
= WiFi
o VPN 2023-07-10 16:41:58 Uplink status changed Wi-Fi(STA) is disconnected
@ Security 2023-07-10 16:40:32 Uplink status changed Wi-Fi(STA) is connected
& Services 2023-07-10 16:4027 Uplink status changed Wi-Fi(STA) is disconnected
@ System 2023-07-10 16:40:00 VPN status changed IPSec VPN 605-IPSec is connected
2023-07-10 16:39:55 VPN status changed IPSec VPN 605-IPSec is disconnected
2023-07-10 16:39:37 VPN status changed 1PSec VPN 605-IPSec is connected
2023-07-10 16:39:01 Uplink status changed Wi-Fi(STA) is connected
2023-07-10 16:38:53 Uplink status changed Wi-Fi(STA) is disconnected
2023-07-10 16:38:38 Configuration changed Router configuration updated
2023-07-10 16:38:31 Configuration changed Router configuration updated
2023-07-10 16:35:42 Configuration changed Router configuration updated
2M_n71n 16282 Canfiruirstian rhannad L ——

1200f2390tems < [1]2 3 4 5 w12 > 20/pageV

Figure 6-5 Events
The router supports the following types of events:
*  Login successfully/failed
*  Configuration changed
¢ CPU utilization is too high
*  Memory utilization is too high
* VPN status changed
¢ Uplink status changed
¢ Uplink switched
¢  WAN2/LANI switched
*  Detection status changed
e Cellular traffic reaches the threshold
*  Reboot

*  Upgrade

6.6 Logs

The [ logs ] module displays logs recorded during operation of the router, which can be used for
troubleshooting when the router does not work properly. You can download and delete logs.
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)
3% ER6OS & InCloud Manager Internet am > %
@& Dashboard Link Monitoring ~ Clients VPN Events  Logs
B Status -
Level: | ALL Vo Key: Search | | Reset Solines Vv | ManualRefresh v | C
£ Internet
Level Time Content
® Local Network
Emergency Jul 1008:46:48 kemel: [24793.080750] scan_ch_restore - End of SCAN(TYPE: 128, Bandldx: 0), restore to BW(2) channel 42, Total BSS[37]
= Wi
Emergency Jul 1008:46:48 kernel: [24793.080901] AsicSetSyncModeAndEnable(: NotSupportedFunc for this arch(HIF_MT)!
o VPN
Emergency Jul 10 08:46:50 kemel: [24794.135908] 0
@ Security
Emergency Jul 10 08:46:50 kemel: [24794.135927] 1
@ Services
Emergency Jul 1008:46:50 kernel: [24794.135936] 2
8 System
Information 1ul 10 1646:52 charon: 09[IKE] giving up after S retransmits
Information Jul 10 16:46:52 charon: 09[IKE] peer not responding, trying again (4/0)
Information Ul 10 16:46:52 charon: 09[IKE] initiating Main Mode IKE_SA 605-1PSec(7] to 10.5.47.96
Information 1ul 10 1646:56 charon: 06[IKE] sending retransmit 1 of request message ID 0, seq 1
Information 1ul 10 16:47:03 charon: 15{IKE] sending retransmit 2 of request message ID 0, seq 1
Emergency Jul 1008:47:05 kemel: [24794.135941] 3
Emergency Jul 10 08:47:05 kemel: [24809.144991] 0
Emergency Jul 10 08:47:05 kernel: [24809.145014] 1

Clear Logs Download Logs || Diagnostic Logs

liil

Figure 6-6 Logs
Clear Logs: clear running logs of the router.
Download Logs:download running logs of the router.

Download Diagnostic Logs: download log information for troubleshooting, it contains system running
logs, device information, and device configuration.
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mode.

Notes:

Internet

[ Internet ] page, you can set parameters for the uplink interfaces and specify a multi-link work

* Exercise caution when changing settings on the
interruption of the network connection.

Uplink Table

7.1

On the uplink table, you can edit WANT1 and Cellular, and add, edit, or delete WAN2 and Wi-Fi(STA). For
details, see section 4.2 Internet Connection. You can drag icons in the Priority column to reprioritize the

interfaces.

% ER605

7.2

On the [ Internet] page, you can configure link detection and set parameters for the uplink interfaces.

@ InCloud Manager ~ ® Internet

[ Internet ]

page, as doing so may cause an

InHand ER605 User Manual @

Uplink Table

+ Add

Name Status Interface Type
Cellular Enable Cellular: SIM1
WANT Enable WAN
Wi-Fi(STA) Enable Wi-Fi(STA)

g the configuration of the intemet interface or adjusting the priority may cause the device network to be interrupted!

StaticIP

DHCP

Actions

2 Edit | @Policy

2 Edit

2 Edit | Delete

Uplink Setting
Link Detection
Detection Address 1

Detection Address 2

Enabled

@® Link Backup.
Failover Mode:

Load balancing

Detection Item Constraint

Latency less th

Jtter Tess th

[t Tess thay
gnal Strength s greater than

Immediately Switch

Value

200ms

200ms

Figure 7-1 Uplink list

Uplink Settings
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Uplink Setting

Link Detection: O

Test Connectivity to:

Enabled Last Time Detection Item Constraint Value
5 min Latency is less than 200 ms
5 min litter is less than 200 ms
5 min Loss is less than 5%
5 min Signal Strength is greater than Paor

{®) Link Backup
Failover Mode: mmediately Switch
Load balancing

Figure 7-2 Uplink settings

* By default, link detection is enabled. In the private network environment, please manually configure the
address that can be detected or disable the link detection function to ensure the cellular interface
working normally. When this function is disabled, the Status page does not display the transmission
latency, jitter, packet loss rate, or signal strength on each uplink interface.

* If the link detection address is left empty, the system detects the primary dns server address obtained by
each interface. When the IP address of the link detection is filled in, all uplink use this address as the
detection address

*  When the router works in link backup mode, you can enable the items to be detected. The router then
monitors these items and triggers a link switch when any item exceeds the threshold. If no item is
enabled, link switch is only triggered based on priority and connectivity of the links.

*  When the router works in load balancing mode, all the links forward traffic on a per packet basis.
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8 Local Network

On the [ Local Network ] page, you can add local subnets and assign them to clients connected to the router
through the LAN interfaces or SSIDs.

8.1 Local Network List

Click Add or Edit to add a local network or edit an existing local network.

Add the network

-
Mode: ® IPMode () VLAN Only Mode

Type: @ Standard () Guest @

* VLAN: ‘ Please enter an integer within 2-4...

* IP Address/Mask : ‘ 192.168.2.1/24

DHCP Server: @D

DHCP IP Range:: |

Figure 8-1 Adding a local network

Notes:

*  The default local network cannot be removed. You can only change its IP address/mask, and DHCP
server configuration.

*  After a local network is added, its mode cannot be changed.

e  The VLAN Only mode is used for transparent transmission of Layer 2 protocol packets. Therefore, you
do not need to set the IP address/mask and DHCP Server for this mode.
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The ER605 can serve as an AP to provide multiple SSIDs for wireless network access. You can define SSIDs
for different purposes and set parameters for these SSIDs.

% ER605 InCloud Manager Internet
@ Dashboard SSIDs Portal
B Status ‘ + Md‘
O i SSID Status Network Band(Channel) Security Encryption Actions
@ Local Network
eht-2g Enable Default 246GHz (6) WPA2-PSK ccmp 2 Edit
= Wii
eht-5q Disable Default 5GHz (149) OPEN : 2 it
% VPN
@ Secuiity
@ Services
O System

Figure 9-1 Wi-Fi list

Click Add or Edit to add an SSID or edit an existing SSID.

Edit eht-2g

#55ID: | eht-2g

Status: @

+Band: @ 246Hz O
* Secuity: | WPA2-PSK
Encryption: | CCMP
IS p——
* Network: | Default

* Channel: | 6

+ BandWidth: | 40MHz

User Isolation: ||

Hide sSID: [ |

Figure 9-2 Editing an SSID

*  The router has two default primary SSIDs, one for the 2.4 GHz band and one for the 5 GHz band. You
cannot change the bands of the two SSIDs or delete the SSIDs.

e After an SSID is added, its band cannot be changed, and its channels are automatically synchronized
with channels of the corresponding primary SSID.
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e Ifyou have added the Wi-Fi(STA) interface on the [ Internet] page, none of SSIDs on the same band
as the Wi-Fi (STA) interface can be enabled, until this interface is removed.
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10 VPN

A virtual private network (VPN) is a private network established on a public network for encrypted
communication. A VPN gateway encrypts data packets and translates destination IP addresses of data

packets to implement remote access. The VPN service can be provided through a server, hardware client, or
software client.

10.1 IPSec VPN

IPSec VPN is an open network security protocol suite developed by IETF to ensure secure data transmission
over the Internet through source authentication, data encryption, data integrity check, and anti-replay at the
IP layer. This protocol suite lowers the risks of data leakage and interception, and ensures the data integrity
and privacy, thus protecting the security of communication.

Choose VPN > IPSec VPN, and click Add to add an [ IPSec VPN. ]

;;};, ERB05 & InCloud Manager @ Intemet adm v+ W
@ Dashboardl IPSecVPN  L2TP VPN
B status + Add
& internet Name IKE Version Uplink Interface Peer Address Local Subnet Peer Subnet Actions
@ Local Network
605~ IKEVI WANT 105.47.122 192.168.66.0/24 192.166.2.0/24 2 Edit | O Delete
= Wi
¥ VPN
@ Ssecurity
@ Services
O System
};?MERBUS & InCloud Manager  ® Intemet
Akt € Add IPSec VPN
B st
* Name:
& Internet
IKE Version: KEV1
@ Local Netwark
* Pra-Shared Key:
= W
Uplini Interface WaNT
= veh
* Peer Address:
O Security
Tunnel Mode:
@ Services
Local Subnat:
© System
+acd
Paer Subnet:
+ acd
IKE Policy

Encryption AES128
Authentication: SHA1
DH Groups:

* Lifetime (seconds): 86400
IPSec Policy

Security Protocol Esp

Encryption

Authent

PFS Groups

= Lifetime (seconds): 86400

Figure 10-1-2 Setting the new IPSec VPN

After the IPSec VPN configuration is completed on both sides, an IPSec VPN tunnel is established. To check the status
of this tunnel, click Status on the left pane, and then click the VPN tab. The following parameters must be set:

¢ Name: specifies the name of the [PSec VPN created on the router, which is used for local VPN management.

¢ IKE Version: specifies the version of the Internet Key Exchange (IKE) protocol used on the router, which can be
IKEv1 or IKEv2.
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*  Pre-Shared Key: specifies the authentication key for IKE negotiation, which must be consistent on both sides.
* Internet Interface: specifies the local uplink interface used to establish the IPSec VPN tunnel.

*  Tunnel Mode: specifies the IP packet encapsulation mode on the IPSec VPN tunnel, which can be tunnel mode or
transfer mode.

*  Peer Address: specifies the IP address of the peer device that will establish a tunnel with the ER605.
Notes:

When two ER series routers establish an IPSec VPN tunnel, the one using a public IP address acts as the
server by default. On the IPSec server, the peer IP address must be set to 0.0.0.0. On the IPSec client, the peer IP
address must be set to the public IP address of the server's interface used to establish the tunnel.

*  Local Subnet: specifies the [P address segment of the traffic to be sent out by the ER605 through the
IPSec VPN tunnel.

*  Peer Subnet: specifies the IP address segment used for communication on the other end of the IPSec
VPN tunnel.

* IKE Policy: allows you to set IKE parameters.

B Encryption: specifies the encryption algorithm for IKE.

B Authentication: specifies the authentication algorithm for IKE.
B DH Groups: specifies the DH key exchange mode.
|

Lifetime: specifies the lifetime of the IKE security association (SA). The default value is 86400
seconds.

*  IPSec Policy: allows you to set [PSec parameters.
B Security Protocol: specifies the security protocol used for the External Router Protocol (ERP).

B Encryption: specifies the encryption algorithm for the Encapsulating Security Payload (ESP)
protocol.

B Authentication: specifies the authentication algorithm for ESP.

B  PFS Groups: specifies the Perfect Forward Secrecy (PFS) mode, which improves the
communication security through an additional key exchange in Phase 2 of negotiation.

B Lifetime: specifies the lifetime of the [PSec SA. The default value is 86400 seconds.

10.2 L2TP VPN

Layer 2 Tunneling Protocol (L2TP) is a tunneling protocol for virtual private dial networks (VPDNs). This
protocol establishes a tunnel from a remote site to the headquarters of an enterprise over a public switched
telephone network (PSTN) or integrated services digital network (ISDN) through Point-to-Point Protocol
(PPP) negotiation. This tunnel allows remote users to connect to the intranet of the enterprise in a secure
way.

10.2.1 Client

The ER605 can serve as an L2TP client to establish a tunnel to a remote L2TP server. Choose L2TP VPN >
Client onthe [ VPN ] page, and click Add to add an L2TP client.
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& InCloud Manager ~ ® Intemet

@ Dashboard IPSec VPN L2TR VPN

Server | Client

& Internet
® o Name Status Uplink Interface Server Address. Authentication Mode Tunnel Verification Actions
= wi
o e |
® Secuy
@ Services
& Syptem
[~
uipn‘}n'u ERB05 & InCloud Manager ® Intemnet
@ Dashboard
< Add L2TP Client
B Status
& |Internet # Mame:
# Local Network Status: [ 9)
= Wi NAT:
%' VPN Uplink Interface: A ny v
O Security # Server Address:
@ Services # User Name:
& System * Password: @

Authentication Mode: AUTO v

Enable Tunnel Verification:

Save Cancel

Figure 10-2-1-a/b Adding an L2TP client
¢ Name: specifies the local identifier of the L2TP client.
e Status: enables or disables L2TP tunneling on the client.

¢ NAT: enables or disables network address translation (NAT) for packets forwarded by the router for the clients
connected to it.

¢ Uplink Interface: specifies the uplink interface used to establish a tunnel from the L2TP client to the server.
¢ Server Address: specifies the IP address used by the remote L2TP server to communicate with the L2TP client.

¢ User Name/Password: specifies the user name and password for L2TP negotiation, which must be consistent on
both ends of the tunnel.

*  Authentication: specifies the authentication mode for the L2TP tunnel.

¢ Enable Tunnel Authentication: When this option is selected, make sure both ends of the tunnel are configured
with the same server name and verification key.

10.2.2 Server

Generally, an L2TP server is deployed at the headquarters of an enterprise to provide remote access for
employees on the move or in branches. On the VPN page, choose L2ZTP VPN > Server to display the L2TP
server configuration page.
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=
;ﬁ,\m‘u ERBO5 & InCloud Manager ® Intemet
@ Dashooard IPSecVPN  L2TP VBN
S Server Client
& Internet
Name: L2TP Server
@  Local Network
Status: >»
= WiFi
Uplink Interface: Any
% VPN
* VPN Connection Address:
Security
IP Pool: =
Services
* User Name:
O System
* Password :
Authentication Mode! AUTO
Enable Tunnel Verification:
Save Reset

Figure 10-2-2 L2TP server configuration
¢ Name: displays the name of the L2TP server, which cannot be changed.
e Status: enables or disables the L2TP server function. This function is disabled by default.
¢ Uplink Interface: specifies the uplink interface used to establish a tunnel from the L2TP server.

* VPN Address: specifies the gateway address for the L2TP client. The gateway assigns an IP address to the L2TP
client from the specified IP address pool.

*  Address Pool: specifies the IP address range for the L2TP client.

¢ User Name/Password: specifies the user name and password for L2TP negotiation, which must be consistent on
both ends of the tunnel.

*  Authentication: specifies the authentication mode for the L2TP tunnel.

¢  Enable Tunnel Authentication: when this option is selected, make sure both ends of the tunnel are configured
with the same user name and password.

10.3 VXLAN VPN

VXLN is essentially a tunneling technology that establishes a logical tunnel on the IP network between the
source network device and the destination network device, and forwards user-side packets through this
tunnel after specific encapsulation.

Choose VPN > VXLAN VPN, and click Add to add an [ VXLAN VPN. ]
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3%, ER6O05 & InCloud Manager
@ Dashboard

B Status

@ Internet
< Add VXLAN VPN
& Intemet

+ Name
Status:
@ Local Network
= Wik

Uplink Interface
¢ VPN

@ Security

«©
WAN1
# Peer Address:
# VNI:
@ Services

Local Subnets:
o System

c

192.168.95.1/24(Default)

ancel
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The following parameters must be set:

Figure 10-3-1 Adding an VXLAN VPN
Name: specifies the name of the VXLAN VPN created on the router, which is used for
management.
°

VXLAN VPN
Peer Address: specifies the IP address of the peer device that will establish a VPN with the ER605.
VXLAN VPN tunnel.

VNI: It is the network identifier of VXLAN VPN and needs to be consistent with the device that
establishes VXLAN VPN with ER605, The VNI of each VXLAN network is unique.

Local Subnet: specifies the IP address segment of the traffic to be sent out by the ER605 through the
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11 Security

On the Security page, you can configure advanced security features, including firewall, policy-based routing,
and traffic shaping.

11.1 Firewall

You can set inbound and outbound rules and port forwarding for the firewall.

11.1.1 Inbound and Outbound Rules

You can set inbound and outbound rules to control inbound and outbound traffic on an interface. For
example, if a large number of attacks are initiated from an IP address, you can set an inbound rule on the
firewall to restrict traffic sent from this IP address.

If you want to prevent some internal users from accessing the Internet, set an outbound rule to restrict
outbound traffic sent from these users. Inbound and outbound rules contain the same parameters and differ
only in default settings. The following figure shows an example of adding an inbound rule.

.f,;‘}n’.u ER605 & InCloud Manager @ Internet

@ Dashboard Firewall  Policy-Based Routing  Traffic Shaping

B status -
Inbound Rules Outbound Rules Port Forwarding MAC Address Filter

Internet
= + Add

@ Local Network
Priority Name Status Interface Protocol Source Destination Behavior Actions

= WiFi

@ Senvices

o gstem
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Add Inbound Rules %
* MName:
status: @D

Interface: | Any
Protocol: | Any
Source: | Any
Destination: | Any

Behavior: (8) Permit Deny

Figure 11-1-1-a/b Adding an inbound rule
Name: specifies the local identifier of the inbound rule.
Status: enables or disables the rule.

Interface: specifies the traffic forwarding interface. For an outbound rule, select the interface from
which traffic is sent out. For an inbound rule, select the interface on which traffic is received.

Protocol: specifies the protocol type of packets to be matched. Options are Any, TCP, UDP, ICMP,
and Custom.

Source: specifies the source IP address of packets to be matched. You can enter an IP address or retain
the default option Any.

Destination: specifies the destination [P address of packets to be matched. You can enter an IP address
or retain the default option Any.

Behavior: specifies the action taken for packets matching the rule. Options are Permit and Deny.
Inbound rule: controls external traffic received by the router. By default, all external traffic is denied.
Outbound rule: controls traffic sent out through the router. By default, all outbound traffic is permitted.

You can reprioritize inbound and outbound rules on the rule list.

11.1.2 Port Forwarding

After a port forwarding rule is configured on an interface of the router, the router forwards data traffic
arriving at this interface to the specified port on the target internal client. In this way, services deployed on
the intranet are available for external users. The port forwarding feature allows the router to forward packets
of different ports to different private IP addresses and ports, so that the same public IP address can be used to
access multiple servers. For example, if external users need to access the service with port 1024 on the client
with the IP address 192.168.2.10, you can map this port to port 1024 on WANI. Then, external users can
access data of this service on the client by entering https://IP address of WAN1:1024 in the address box of
their web browser.
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® Dsshboard Firewall  Policy-Based Routing Traffic Shaping

Inbound Rules || Qutbound Rules | Port Forwarding

+ Add

Name Status Interface. Public Port Protocol Local Address Local Port Actions.

Add Port Forwarding X

* Mame!:
status: @D
Interface: | Any
Protacol: | TCP&UDP
* Public Part:
¥ Local Address:

* Local Port:

Figure 11-1-2-a/b Adding a port forwarding rule
¢ Name: specifies the local identifier of the port forwarding rule.
e Status: enables or disables the port forwarding rule.

¢ Interface: specifies the uplink interface that provides port mapping for internal clients. This interface must have a
public IP address.

*  Protocol: specifies the protocol type to which port mapping is applied. Options are TCP, UDP, and TCP&UDP.

¢ Public Port: specifies the protocol port on the uplink interface to be mapped to the protocol port on the internal
client. The value range is the same as that of Local Port.

*  Local Address: specifies the IP address of the target client that external users need to access.

*  Local Port: specifies the protocol port that external users need to access on the target client. The value range is the
same as that of Public Port.

11.1.3 MAC Address Filter

MAC address filtering refers to prohibiting (allowing) computers in the MAC address list from surfing the
Internet, that is, controlling the Internet access requests of computers in the LAN through MAC addresses on

the router.
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3%, ER6OS & InCloud Manager @ Internet adm~ %
@® Dashboard Firewall  Policy-Based Routing  Traffic Shaping

B Status
Inbound Rules | Outbound Rules Port Forwarding MAC Address Filter

& Internet ;

MAC Address Filter Table
@ Local Network @ Unlimited Blackiist Whitelist Reset
= WiR

+ Add
% VPN

MAC Address Description Actions

@ Security

@ Services

o System

No data

1-1of litems < >

+ Add
MAC Address Description Actions

Please enter Please enter [E)1Save X Cancel

Figure 11-1-3 a/b Adding a MAC Address Filter rule
You can create multiple MAC addresses in the list, add a description of the address, and set the MAC
addresses in the list to access the network (whitelist), or you can disable MAC addresses in the list to access

the network (blacklist).

11.2  Policy-based Routing

Policy-based routing (PBR) allows the router to forward different data flows through different links based on
the configured policies. This feature enables flexible route selection and control, thus improving the link
utilization and reducing operational cost of the enterprise. Choose Security > Policy-based Routing and
click Add to add a PBR rule.

3%, ERE05 & InCloud Manager  ® Intemet

@ Dashooard Firewall  Policy-Based Routing  Traffic Shaping

B sttus + Add

B Inieret Priority Name. Status Protacol Source Destination Export Actions

No Data
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Add Policy-Based Routing X
* Name: | Please ente
status: @D
Protocaol: | Any W
Source: | Any b4

Destination: | Custom v

Output: | WAN1 b4

Figure 11-2-a/b Adding a PBR entry
Notes:

®  The source and destination addresses of the PBR entry cannot be set to Any at the same time.

11.3 Traffic Shaping

To optimize your network, you can create shaping policies to apply per-user controls on a per-protocol basis.This
allows you to reduce bandwidth for recreational traffic, and to prioritize bandwidth for your business-critical enterprise
traffics.Choose Security > Traffic Shaping and click Edit to modify the bandwidth of the uplink.

3%, ER605 & InCloud Manager ~ ® Intemet

® Dashoosrd Firewall  Policy-Based Routing  Traffic Shaping

Uplink Bandwidth

Uplink Interface Up Bandwidth Down Bandwidth Actions

@ Local Network.
WANT Unlimited Unlimited 2 Edit

Celular + Unlimited Unlimited 2 Edit

Queue Name Status  Protocol Source Destination Priority DSCP Tags Limit Bandwicith Reserved Bandwidth  Actions

Figure 11-3-a Editing uplink bandwidth

Click Add Create a new rule to add a traffic shaping rule. Traffic shaping policies consist of a series of rules that are
performed in the order in which they appear in the policy, similar to custom firewall rules. There are two main
components to each rule: the type of traffic to be limited or shaped (rule definition), and how that traffic should be
limited or shaped (rule actions).
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%, ERB0S @ locicixtiase B o Viturat adm~ %
@ Dashbezrd & Add Traffic Shaping Rules

B status
& Internet *Name:
@ Local Network Status ©
= wiF protocal Any v
o veN Source: Any v
© security Destination: Any v
© services Pricrity Highest v
€@ system DSCP Tags: Do not change DSCP tag v
Limit Bandwidth O 0 Mbps v
Down: O 0 Mbps v
Reserved Bandwidth: U O 0 Mbps v
Down: O 0 Mbps v

save Cancel

Figure 11-3-b Adding traffic shaping rule
Note:

e  Traffic forwarding priority for unmatched rules is medium.
e  When the bandwidth is set to 0, the rate of traffic is not limited.

e  The value of guaranteed bandwidth should not be greater than the limit bandwidth.
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12 Services

12.1 Interface Management

Inthe [ Interface Management ] module, you can specify the local subnets allowed to communicate with
external networks, and set a rate limit for the interface.

32, ER605 & inCloud Manager ~ ® Intemet adm v
@ Dashboard
Interface Management v
B Status
Interface Status. Network Link Rate
& Internet
i Enstle i Ao
® LocNetwork
e Enatle " Avto
= Wi
LNz Enatle al Avto 2 eat
= v
LANS Enable Al Auto £ Edit
© Secury
® Services DHCP Server ”
8 Sptem
Fixed Address List >
Static Routes. >

Interface: LAM1

status: @D
* Network: | All
¥ Link Rate® | Auto

Cancel Save

Figure 12-1-a/b Editing a LAN interface

12.2 DHCP Server

DHCP implements dynamic IP address allocation in a client/server model. The client sends a configuration
request to the server, and the server replies with an IP address assigned to the client.

2% ERBOS & Incloud Manager  ©  Intemet m
@ Dashooars

Interface Management >
B seus
S rione DHCP Server v
Stk Network Status DHCP IP Range Lease oNs Actions
i Default Enable 192.168.66.1 - 192.166.66.254 1 day Auto 2 Edit
VN
Securiy Fixed Address List >
® Senices

Static Routes >
o syptem
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Edit DHCP Server

Network: Default

10,5.22.1/24
status: @D

* DHCP IP Range:

10.5.22
¥ Lease:

1 day

W
* DNS: | Auto

Cancel

Figure 12-2-a/b Editing a DHCP server
network is removed, the DHCP server for this network is also removed.
networks in VLAN Only mode.

-
&%, ERBO5 inCloud Manager ~ ® Internet
@ Dashboard
LAN2 Enable
B Status
LAN3 Enable
& Internet
LAN4 Enable
@ Local Network
= DHCP Server
% VPN
@ Security
@ Services

All
DNS Server

Al
o System

Auto
Auto
Auto
Al Auto
The DNS Server takes effect globally, but the link detection and switching logic of the original uplink interface are not affected !
DNS Server1:
DNS Server2:
Save Reset

Fixed Address List

Static Routes

Dynamic DNS

Passthrough Settings

Figure 12-3 Adding DNS Servers

12.4 Fixed Address List

You can assign fixed IP addresses to clients connected to the router based on their MAC addresses.
39

10.5.22.254

DHCEP servers are created on the router based on local networks connected to the router. When a local
12.3 DNS Server

DNS servers resolve domain names to IP addresses, making it easier for users to surf the Internet.

dr
2 Edit
2 Edit

2 Edit

adm v

The DHCP server function is available only for local networks in IP mode. It does not take effect for

£
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@ Doshioard
Interface Management >

DHCP Server >

@ Local Network

0 i S
E Fixed Address List

- +Add Network: | Al Network v | [ Paddes v | plesseenier
@ Security Network. MAC Address 1P Address Clients Actions
® Services | [ etautt v il BSave | X Cancel

o S

et <[T]>

Static Routes >

Figure 12-4 Adding a fixed IP-MAC address mapping
*  The IP address assigned must be in the IP address range of the local network in IP mode.

*  When a local network is removed, all the address mapping entries in the IP address range of the network
are deleted.

12.5 Static Routes

You can configure static routes to direct data traffic to specified routes and interfaces. The static route list
displays only manually created routes and does not include the routes generated automatically on uplink
interfaces.

Add Static Routes

* Dest Add/Dest Net:

-

* NextHop:

* Priority: | 60

Figure 12-5 Adding a static route

e Static routes to the same destination IP address or network cannot have the same next-hop address,
outbound interface, or preference.

*  When WAN2, Wi-Fi(STA), or the interface serving as an L2TP VPN client is removed, static routes
using this interface as the outbound interface are also deleted.

12.6 Dynamic DNS

Dynamic DNS is a technology in the Domain Name System that automatically updates the content of
name servers, and according to the domain name rules of the Internet, domain names must follow a
fixed IP address. Dynamic DNS provides a fixed name server for dynamic domains, which enable
external users to connect to dynamic users' URLs through timely updates.
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‘Add Dynamic DNS

Service Provider: | dyndns \/J

htps://www.dyndns.org

* Hostname: |
* Username: |

+ Password: |
+ Update Time(Minutes): | 60 |

Uplink Interface:  WANT

Figure 12-6 Adding a Dynamic DNS

*  Service Provider: It is provided by Dynamic DNS operators, You can choose dyndns, 3322, oray, no-ip,
or customize (URL required).

*  Hostname: Click the URL below Service Provider to register to get the hostname.
*  Username: Click the URL below Service Provider to register to get the username.

*  Password: The password set by the user at the time of registration.

12.7 Passthrough Settings

After the passthrough function is enabled,the uplink interface can be transmitted transparently to the client

S
3%, ER6O5 InCloud Manage Internet
@ Dashboard Interface Status Network Link Rate Actions
B Stat LANT Enable All Auto 2 Edit
us
LAN2 Enable Al Auto 2 Edit
£ Internet
LAN3 Enable Al Auto 2 Edit
@ Local Network
LAN4 Enable Al Auto 2 Edit
= WiFi
& e DHCP Server >
O Security
® seiices DNS Server >
@ System - -
Fixed Address List >
Static Routes o
Dynamic DNS >
Passthrough Settings v

1PPassthrough: () ©

Passthrough MAC: | |o

Figure 12-6 Enabling the Passthrough function
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Passthrough MAC:Only the client bound t the MAC can obtain the Passthrough address.
Note:

*  After the IP Passthrough mode is enbled,only one client can access the Internet.The following function will be
disabled.

Static routing, VPN, Port Forwarding,Policy-based Routing, SD-WAN Overlay, Connecor.
*  When access the client device,the inbound rule needs to be released.

3 You can still access the router via the IP address of the default subnet
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13 System

On the System page, you can configure various functions, including cloud management, remote access
control, clock, device options, configuration management, alarms, tools, and log server.

13.1 Adm Management

The initial user name for the router is adm and the initial password is 123456. Change the password to
enhance security. Click adm in the upper right corner of the page, and select Change Password.

%, ER60S & InCloud Manager ~ © Intemet

ame: ERE05 £ odel: ERG5-NRQ2-WLAN Seria Firmware Version: V203

IAC: 00:1805:0002:04 ptime: 1w cess: WANI Uplink IP: 10547.158

3y IP: 1921686610 System Time: 2022-12-26 154408 UTC +0800

& VN Interface Status

m,,
® seis -

Cellular WANT  LAN1 LAN2 LAN3 LAN

Traffic Statistics

Cellular(SIM1)

Wi-Fi Connections Clients Traffic Top5

Modify Password X

Username: adm
¥ Mew Password !

* Confirm Password

Cancel Save

Figure 13-1-a/b Changing the password of adm

13.2 Cloud Management

InCloud Manager (star.inhandcloud.com) is a cloud platform developed by InHand to help enterprises
accelerate network deployment, simplify network O&M, and improve service experience. This platform
provides zero touch deployment, intelligent O&M, and security features to create good service experience
for users. When your devices are connected to the cloud platform, you can log in to the platform to manage
the devices remotely, perform batch configuration, and monitor traffic on these devices.
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In the [ Cloud Management ] module, you can select the cloud platform you want to visit. When the cloud
platform and cloud management service are no longer needed, you can disable the cloud service

3%, ER605 & inCloud Manager ~ ® Intemet

@ System | Remote Access Control s
System Clock >
Device Options >
Configuration Management >
Device Alarms >
Tools >
Log Server >

Other Settings >

Figure 13-2 Cloud management
Note:

e The ER605 connects to the InCloud Manager platform automatically. If you do not want to use this
platform, disable the cloud service manually.

13.3 Remote Access Control

In the [ Remote Access Control ] module, you can determine whether to allow access to the web-based
management system of the router from the Internet, and specify the allowed protocol ports.

3%, ERB05 & inCloud Manager ~ ® Intemet

Cloud Man

@ imenet Remote Access Control .
® Locl Network

o L “pon: | w3

RN = @ -

© Secury e @

& Senices &

System Clock >

Configuration Management >
Device Alarms >
Tools >
Log Server >

Other Settings >

Figure 13-3 Configuring remote access control

¢ HTTPS: when this service is enabled, you can access the web-based management system of the router remotely by
entering the public IP address and port of its uplink interface in the address box of the web browser.

. SSH: when this service is enabled, you can use a remote access tool, such as CRT, to log in to the web-based
management system of the router by entering the public IP address and port of its uplink interface, as well as the
user name and password.
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*  Ping: when this service is enabled, ping requests can be initiated to the IP address of the uplink interface from
external networks.

Notes:
*  Remote access control does not apply to LAN interfaces.

e  Firewall policies do not restrict remote access.

13.4 System Clock

In the [ System Clock ] module, you can select a time zone for the system and enable the NTP server to
synchronize time with the target NTP server.

System Clock

Time Zone: UTC +08&00 China,Hong Kong,T...

NTP Server: @D

* NTP Serverl: | poolntp.org *Port: | 123
NTP Server2: Port:

Figure 13-4 Setting the system clock

13.5 Device Options

In them [ Device Options ] module, you can reboot the router, upgrade the firmware, and restore factory
settings of the router.

Device Options

Reboot the router Reboot
Upgrade the router firmware version Upgrade
Restore the router to factory settings RS R s S aivly]

Figure 13-5 Device options
Notes:

*  Before upgrading the firmware, make sure the new firmware is obtained from an official source. If a
wrong firmware is loaded, the router will be unable to work.

*  When the router is connected to the cloud platform, the cloud platform synchronizes the settings
configured before you restore the factory settings to the router again. The router only clears historical
data.

13.6 Configuration Management
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You can export the configuration file of the router to your PC as a backup. Once the configuration is lost on
the router, you can import the configuration file to the router to restore the configuration.

Configuration Management v

Local Backup

Figure 13-6 Configuration management

13.7 Alarms

If you need to monitor some events that may occur on the router, select the matching alarm events in the
Alarm Settings module and specify an email address for receiving alarms. When an event of the specified
type occurs, the router sends an email to the specified address. The unselected alarm events are recorded in
logs on the router.

The router supports the following events:

€ Device Alarms

Alarm Settings - [ selectall
(Mail Receiving) User logged in successfully
User login failed
Configuration changes

€PU utilization is too high in the last 5 minutes Over| 70%

Memory

ation is too high in the last 5 minutes  Over| 70%
Cellular traffic reaches the threshold

VPN status changes

Uplink status change

Failover occurs

WANZ/LANT switch

Reboot

Upgrade

EN -
Figure 13-7-a Alarm settings

After you set the mail server address, port, user name, and password, the router uses the specified mailbox to
send alarm emails. You can send a test email to check whether the mail server configuration is correct.

Receive Mail Settings

Enable: (e ]
* Mail Server Address: inhand mail.com.cn
* Mail Server Port: 25
* Username: ts@inhand.com.cn

*password: | e
TLS:
* Receiving Email Address:

+ Add

send a test email to: m

Figure 13-7-b Mail server settings

13.8 Tools
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The ping service is used to test the connectivity between the router and external networks through the
Internet Control Message Protocol (ICMP). Enter any domain name or IP address in the Target field, and

then click Start to test the connectivity with this target.

Ping

* Target 2238
Interface Any

* Packet Size &4

* Packet numbers: 4

B o

PING 8.8.2.2 (8.8.8.8) 64 data bytes

72 bytes from 8.8.8.8: seq=
72 bytes from £3.8.8: seq=3

--- 8.8.8.8 ping statistics -
4 packets transmitted, 4 packets received, 0 Ox1acket loss
round-trip min/aug/max = 89.177/90.346/91.376 ms

13.8.2 Traceroute

Figure 13-8-1 Ping

Enter the IP address of the target host, select an interface, and then click Start to test the route to the

destination IP address.

Traceroute

* Target 2833

Interface Any
- Stop

traceroute to 8.8.8.8 (2.2.8.8), 30 hops max, 38 byte packets
1o

3
41119130247 (111:9.130.241) 28.993 ms 34,698 ms 34,048 ms
5 223.87.26.45 (223.87.26.45) 24.067 ms 27.221 ms 35.846 ms

13.8.3 Packet Capture

Figure 13-8-2 Traceroute

You can capture data packets on a specified interface. By selecting an option from the Qutput drop-down
list, you can view information about the captured data packets or export the information to your PC.

Capture

Interface: Any
Filter Expression:

# Time: 60 e

Qutput:

View output below

Sample filter expressions

e.g.Packets to and from ip address 1.1.1.1: host 1.1.1.1

e.g.Packets to and from ip address 1.1.1.1 and TCP or UDP port 53
host 1.1.1.1 and port 53

e.g.All ICMP packets that are not echo requests/replies:
icmplicmptype] (= icmp-echo and icmplicmptype] |= icmp-echoreply
e.g.,Ether host 1 3:44:55:66!

ether host 11:22:33:44:55:66

For mere information, please refer to:  http://www.tcpdump.or

8
&

Figure 13-8-3 Packet Capture

13.9 Log Server
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After you enable the log file server feature, the device periodically uploads log files to the specified server.

&
3% ERBOS & InCloud Manager ~ ® Internet am~ %
@ Dashboard
B Status Remote Access Control >
& Intemet
System Clock >
@ Local Network
= Wil Device Options >
¢ VPN
Configuration Management >
@ Security
L B Device Alarms >
& System
Tools >
Log Server v

Enable log Server: ()

Server Address1: Port : 514
Server Address2: Port : 514
Save Reset
Other Settings >

Figure 13-9-1 Adding Log Servers

13.10 Other Settings

13.10.1 Web login management

You can set the time that log out automatically.

=
§¥: ER605 & InCloud Manager @ Interet am v %
inhand g
@ Dashboard
Configuration Management >
B Status
& Internet Device Alarms >
@ Local Network
Tools >
= WiFi
o VPN Log Server >
© secunty
® lonice Other Settings v
© System
& Web login management
Web login for | 300 minutes automatically Iog out
Save Reset
Automatically Restarts: [® Jo)
Save Reset
SIP AIG: [ e)el
Save Reset

Figure 13-10-1 Setting the automatically log out time

13.10.2 Automatically restart

When this feature is enabled, the device will automatically restart when the device cannot connect to the

network and cannot be retried for one hour.
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J,ﬁn"u ERB05 @ InCloud Manager @ Intemet

@ Dashboard

Configuration Management >
B Status
&€ Intemet Device Alarms 24
@ Local Network
Tools >
= Wifi
7 Log Server >
@ Security
i v
. e Other Settings
© System
. Web login management
Web login for | 300 minutes automatically log out
Save Reset
Automatically Restarts: (@ Xo)

SIPALG: [ e)ol

Figure 13-10-2 Enabling the Automatically restart function

13.10.3 SIP ALG

It generally functions as a firewall and consists of two technologies, one is the session initiation protocol(SIP) and the

other is the application layer gateway (ALG)

. ER605 & inCloudManager  ® Internet
@ Dashboard
Configuration Management >
B Status
& Intemet Device Alarms >
@ Local Network
Tools >
= Wi-Fi
EERVER Log Server >
© Security
o e Other Settings v
O S | Web login management
Web login for | 300 minutes automatically log out
Automatically Restarts: » o
Save Reset
SIP ALG: [ e}o)
Figure 13-10-3 Enabling the SIP ALG function
Note:

When this function is enabled,it will affect VoIP phone communication.
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